INTERMEDIATE PHOTOSHOP

What is Photoshop Elements?

Photoshop Elements is a streamlined version of Adobe Photoshop CC. Despite missing some more advanced
features, it is a robust piece of software capable of handling many types of projects. You can buy Photoshop
Elements as a one-time purchase instead of a monthly subscription like the full version.
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GETTING STARTED

In Intermediate Photoshop, we will collaboratively walk N\
/ ; \
through all the steps it takes to combine two photographs. Today We’ll Cover
|
Today, we’ll be using Photoshop Elements. Elements is a I Selecting images to Photoshop I
less expensive version of Photoshop, bought in a one-time I Preparing Images I
purchase instead of a monthly subscription like the full I e Copying and Pasting I
version. Despite missing some more advanced features, I e Transforming Image I
Photoshop Elements is a robust piece of software capable I . I
) ] 1 Magic Lasso Tool
of handling many types of projects. ) o I
| ® Adjustlighting |
By This Time You Should Know: I+ Copying and Pasting Textures I
I e MergeVisible I

e Basics of layers I e BlurTool |

* Simple photo editing \ e Magic Band-Aid Tool ]

e Saving in Photoshop \ s

e Basic Keyboard commands (cut, paste, undo,redo) ~ —~ — T T T T T &7 &7 & =
Selecting an Image T AR
Probably the most important part when combining images SSODGHE | sutron wau .

happens way before you open up Photoshop. When selecting
photos to combine, you’ll want to pay attention to the lighting in
each, as well as the size of both images, and the posture or
scenery in the photos.

For the most part, search for large or medium file sized photos,
as smaller sized images may create difficulties when editing. You
can limit your search in Google images based on file size after
opening the “Search Tools”, as seen below.

Multiple Images into Photoshop

Web  Images  Shopping  Videos  News  More~  Search fools

Size ~ Color = Type ~ Time ~ Usage rights ~ More tools ~

First, we’ll need to bring our images into Photoshop. Simply drag them onto the Photoshop icon. Drag
Intermediate Photoshop Image 1 + 2 into Photoshop Elements now. When multiple images are opened in
Photoshop, they appear in separate tabs. You can move between images by clicking on either tab.

| x © intermediate Photoshop image 1.jog @ 48.8% (RGB/8) * | x intermediate photoshop image 2 .jpg @ 40.7% (RGB/8) *

© intermediate Photoshop image 1.jpg @ 48.8% (RGB/8) * |
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PREPARING OUR IMAGES

Now, unless we were very lucky and the photos are the same size and quality, we will need to make some

adjustments to our images.

Image Size
! BuEEEN Enhance  Layer Select Filter View Window

The first thing we’ll want to review is the term Dpi. i Rotate > _

. . . . .. Transform > 3
Dpi describes the resolution of the image. When combining J Crop L eLive
images, we’ll want the resolution, or pixel size, to be the iir  Recompose ediate photoshop image 2 .jpg @ 40

Divide Scanned Photos
same. Resize > Image Size... X8l
TR % Canvas Size... X#C
i i Scale
To do th.IS, open up the Image Tab, select Resize, and select ComvertColor Profile. b o .
Image Size. ~
& LN -
P S . NS
e Image Size | :
@ Learn more about: Image Size
— Pixel Dimensions: 5.72M Cencel 1§
Width: 2000 pixels 1
Height: 1000 pixels
Bocument Size: Next, we'll set the resolution. For large and printed
Width: [6.667 | | Inches v materials, we’ll want to set the resolution to 300 Dpi.
Height: [3.333 | Inches v| ]8
. -
SR | [Poetainen ] Also remember, you can always reduce quality but it’s

R  impossible to add information/quality to our file later.
[¥| Constrain Propartions For most documents, 300 Dpi is appropriate. Beyond
| esamete image 300 Dpi is excessive and can lead to extremely large
file sizes (but may be used for extremely large

Bicubic (best for smooth gradients) -

printouts).
¥ 3 Edit MIUELEE Enhance Layer Select Filter View Window Help
Fllpp lng Rotate 90° Left
oo \out
g:nom... .jpg @ 40.7% (RGI

When looking at image 1 and 2, you’ll also need to consider ot

Flip Vertical

which directions both photos are facing because we’ll want to

Free Rotate Layer
Rotate Layer 90° Left
Rotate Layer 90° Right
Rotate Layer 180°

Flip Layer Horizontal
Flip Layer Vertical

Straighten and Crop Image
Straighten Image

flip those now to face the same direction.

In this case, we’ll flip the chameleon horizontally by selecting
the Image Tab, then Rotate, and Flip Horizontal.

Now we should be ready to start editing these images together.
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COMBINING IMAGES

Cutting and Pasting

The basics of almost all intermediate Photoshop skills is cutting and pasting. Similar to the operation in a
Word document, we will be using the same principles to select one part of an image and cut/copy that
portion onto another.

The first way to cut and paste in Photoshop is using the
rectangular selection tool. Using this, we can draw a
rectangle around the chameleon’s head.

Hit CTRL+C and select our other image and enter CTRL+V.

Our image is now placed on
top. As you can see though,
using the rectangular selection
leaves a lot of unwanted
background in our selection.

SELECT
Lasso Tool T
buwd

A better way to copy and paste a portion of an image, though, is to use the Lasso oo
Tool. The Lasso Tool works like the square selection tool except that you can p =N
move around certain parts of the image. Because we are copying something with ENHANCE
an irregular shape, we’ll want to use the Lasso Tool. -i-Q> v/
& L

Select the Lasso Tool and draw around your

chameleon’s head. Then cut the chameleon’s A &

head and paste into onto our first image.

If you make a mistake, simply hit the ESC key
and start over.

Once the image is pasted, you’ll also notice that a new layer is created.

We should now have two layers, one that is the chameleon and the other
that is our fish.
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Transforming the Image

Once the image is pasted onto image one, you’ll notice a
square border around the new layer. You can now
change both the images size and rotation by clicking,
holding, and dragging.

Use the bisecting boxes on the side to increase the size.
To rotate, move the mouse to the corner until you see
the rotation symbol.

VIEW x @i
QM Magic Wand
fELEf: You'll notice, we still have some excess background on our chameleon. Similar to the
+ i regular lasso, the Magic Wand does all the selecting work for you. Clicking and
- L% drawing with the Magic Wand Tool selects and highlights based on shape. Select the
ENHANCEJ background and click Delete to remove unwanted background. If you make a mistake
o ;90 use CTRL+Z to undo your deletion.
¥ 4L
a &
Eraser Tool ¢ ©
DRAW
Now we should have a chameleon head that matches the relative size of the salmon. / 4|
There’s still a slight border that the Magic Lasso didn’t remove, so we’ll also want to S
erase that using the eraser tool. "‘ﬂ P
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Now our fish is coming along nicely.
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Adjust Lighting

Based on what we have now, you can see that the chameleon head is not blending into our image for a few
reasons. The first being that the lighting is both too bright and has too much contrast.

~«r [ Using the Enhance Tab, let’s bring up the Levels. Make the

age Layer Select Filter View Window Help
Auto Smart Tone...
Auto Smart Fix X#M B +
s ol eLive | Quick

nage : Auto Contrast

Auto Sharpen

Adjust Lighting
Adjust Color

[ Unsharp Mask...

Auto Color Correction

Auto Red Eye Fix

Adjust Smart Fix...

Convert to Black and White...

Adjust Sharpness...

X{8L jtoshop image 2 .jpg @ 40.7% (RGB/
%8B

Shadows/Highlights...
Brightness/Contrast...

meld together visually.

chameleon’s head darker by bringing the blacks up and reduce the
contrast by changing the mid-tones. This will allow the images to

— — — — .oc ‘
Levels H
e As a reminder, always make sure that you have the layer
B [ cancol | selected you would like to edit. If you have the incorrect
ke ole e layer selected, either nothing will happen, or you may
Auto
‘ S make changes to the background unknowingly.
[ Preview
- ) o Create -~ Share =
3] 118 255 bt
Output Levels: 9 @, 0 @ By T -= S
s e Opacity: [100% - |
0 255
®f 2 Layer 1

Using Pre-existing Textures

The next thing we’ll want to do is remove the salmon
visible between the chameleon’s mouth. The easiest
way to do this is to use a pre-existing texture/image
to cover it up. Simply use the Selection Tool to copy a
portion of the water and paste it back onto the
image. Use the Pointer Tool to drag it over until it is

in the correct location.
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Layer Select Filter View Window Help

Ao S Tone.. wr

Auto Smart Fix X#M . 5 g ° °

Auto Levels 5 (o ol CuIck [RGuided B Ad.] ustlng Color
31.8% Auto Contrast XO%L ;@ 100% (Layer 1, RGB/S) * |

- Auto Color Correction 08B

Auto Sharpen ’

Auto Red Eye Fix ®R |
. Adjust Smart Fix... T®M
it Adjust Lighting > |

Remove Color Cast...
Adjust Hue/Saturation... 88U
' Remove Color 08U
Replace Color...

Adjust Color Curves...
Adjust Color for Skin Tone...
Defringe Layer...

Adjust Color

Convert to Black and White...

3 Unsharp Mask...
Adjust Sharpness...
Photomerge®...

Hue/Saturation |:
i @ 1;1na:s-ter -‘-\‘:“2 Uye/Saturation I
Red: a3 b
1 o ‘(Be“OSWS X4 Iﬂ‘
G 5
s O% ” | v
This will open up the Hue/Saturation Menu. Here, we can play E,':;:m X7 —O—
with the colors of the layer easily. Simply adjust the Hue Slider el |
on the top to effect the master color, or select specific colors to " Lightness: o
. —)
adjust from the drop down CJGolorize
menu. 15°/45° 75°\105° A . Hpreview
5 I | =
In this case, we’ll probably

want to make our chameleon
head a slightly muted purple.

Blur Tool

EMNHAMNLE
® i
& L
@ &

the chameleon appear more similar to the background.

["] Sample All Layers

DRAW
Blur : :
- A Mode: | Normal v| Size: dO———————  13px
: | Strength: =  50%
» | Brush: - -

As you can see the level of detail is similar now on the head and
body of our fish.

A

ELMHURST

PUBLIC LIBRARY

125 S. Prospect Avenue, EiImhurst, IL 60126

(630) 279-8696 @ elmhurstpubliclibrary.org

Our next big problem is the differences in color
between the muted salmon and the green chameleon.
Under the Enhance Tab, we can Adjust Color using
Adjust Hue/Saturation features.

If we look more carefully now, we can also see that the chameleon head is in sharper focus
than the salmon behind it. The easiest way to fix this problem is to use the Bur Tool to make

Selecting the Blur Brush, we can paint over the head to decrease the detailed located there.

You can use the menu below to adjust the size and strength the blur brush.
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Correcting with the Spot Healing Brush

ENHANUE

Finally, we will need to hide the lines between our two images. While there are several Q” -1-
ways to do this, the Spot Healing Brush provides nice results with little work. :
o6 &
DRAW
dit Image Enhance Select Filter View Window Help
New >
s ve | auck cuded Inorderto editthem together though, we'll need to
2ipg@318% RCBA)" | | poname L ayer.. B 100% Layer 1,RGB/9) | combine the layers to blend them. This is called “merging.”
AT i | Layer Style >
f o™ | New Fill Layer > 1 To Merge the layers, go to the Layer Tab and select Merge

New Adjustment Layer >

Layer Content Options.

y Layer

Layer Mask L
Create Clipping Mask G

Arrange > ;

Merge Down ®E
Merge Visible ORE
Flatten Image

We should now have a combined salmon chameleon. There
are obviously several more tricks to make this photo more
convincing, but by using these tools you should be able to

merge photos successfully.

e e

Visible. This will combine all our layers together into a

single image.

This means, though, that we will no longer be able to move
parts of the image independently. It is advised to save
several versions while working in order to backtrack after a

merge.

Now that our layers our merged, we can use the Spot
Healing Brush to blend the shapes together. Using trial and
error, merge the shapes together, drawing over them to
combine the sharp lines.
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Combine Images 3 and 4 by:
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/
| Let’s Try It!

N

Adjusting image size
Flipping Image

Resizing and Rotating
Adjusting Levels
Adjusting Hue/Saturation
Blur Tool

Merging Layers

—-— . . - . e e e e .

Spot Healing Brush
/
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